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Introduction

There are many applications of whole heart segmentation. They include:

¢ Volume measurement

* Diagnosis

¢ Visualization of pathology

* Treatment and intervention planning
e Educational tools

* Surface map generation for use in CAD software or 3D printing

The segmentation demonstrated in this e-book uses a combination of semi-automatic and manual techniques. Automatic cardiac
segmentation techniques are an active area of research’, but manual segmentation remains the gold standard. The example in this guide
shows whole heart segmentation at one time point in the cardiac cycle; however, changes through the cardiac cycle can be determined
by performing segmentation at multiple time points (often end-systole and end-diastole). For more information on segmentation and
measurement at different time points, see the Left Ventricle Segmentation and Measurement guide. This approach may be modified for a

specific application or structure of interest.


http://info.analyzedirect.com/left-ventricle-segmentation-and-measurement
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Segmentation Instructions

Load data into Analyze. Select the N— =
. ® &
dataset in the Analyze workspace, and W20

open the Volume Edit module.

Segment > Volume Edit.
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Drawing Walls | Edge Strength| Walls |Semi-Automatic | Manual|

|[¥] Define walls to limit semi-automated operations:

Select the Walls tab and choose the Draw Wall radio button.
Browse @ Draw Wall

Walls drawn on the orthogonal views of the image data will set 3D Wall Type: © Line @ Trace () Spline

limits for the segmentation algorithm. For this segmentation, the _ _— .
) ) ) ) ) [Extend Wall(s): [¥] Transverse [¥| Coronal |¥] Sagittal
main concern is separating the heart from the ribs and spinal cord.

These walls will need to be curved, so select either the Trace or Reset Wall(s): | All | |Trar|5_'n.rer5_e| | Coronal | | Sagittal |

Spline option, then draw walls around the

heart on each orthogonal orientation. The

4 Heart Segmentation - Volume Edit

iew Other Help

@D@@@

L _Woiiginal

walls will be propagated through all slices.

Move through the slices using the slider
below each image, and when the wall

no longer coincides with the position of

the heart, redraw a new wall in that slice.

The wall will be interpolated between the

slices where it was specified.

Tip: Draw walls that are not completed closed

shapes. If the walls are closed, sometimes the
interpolation will not stay around the shape
of the heart. Instead, draw an open U or C
shape, letting natural intensity boundaries in
the image define the open part of the wall.

See screen shot for examples of walls.
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Extracting the Blood Pool T e e T

LB

Select the Semi-Automatic tab, and the

Region Grow radio button.

Name Object 2
Color Red

Click in the blood pool in an orthogonal

Threshold  ® IRegion Grow,
. . Components () Object Extractor () Object Separator
image to set a seed point.
Reassign Object
Min ’ ! Threshold Max
1223 11 3422

[¥] Threshold Rendering

Extract Object|
Reset Seeds. Reset Limits Redo Undo

Point Picied = (227, 191, 314) Value=4a2 (Objec=Originl)
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The grayscale value of the selected point 7. e Seqension Vol 5 =1

File View Other Help

will be set on the Threshold range.

Move the upper and lower limits of the

threshold range to values that describe EmmT o
~ e gl
[] Display [ Locked

the blood pOO|. e

Click Extract Object. The blood pool will
sy 4560

be extracted. T =—

Reset Seeds | [ Reset Limits Redo | [ Undo |
Change the name of the object to Blood

Pool. The regions initially extracted in
this data set are the aorta, left ventricular

blood pool and left atrium.
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Segmenting Regions from et v
oo

the Blood Pool

First we will segment the initial blood pool 7
object into its constituent parts. :

[¥] Display [C] Locked

=
(Bl 5o Avtor e

©) Brows: Threshol Region Grow
Connected Components () Object Extractor ® Object Separator
©) Oblique Cutting © Fill Holes ) Propagate Objects

Under the Semi-Automatic tab, choose © R O

Select two points on the same object. The first
point selected will become the specified object.

Object Separator. Add a new object, P otk oo st

points on the rendering.

Reset Seeds | | Reset Limits Redo Undo.

and then select two seed points. The

first seed point will become part of the

selected object (the new object), and
the second seed point will remain part

of the old object.

In this example, the aorta was separated

from the blood pool object. Parts of the

P 33

Point Picied = (222, 265, 321) Value=412 (Objec=Blood Poal)

coronary arteries were also automatically
included in the aorta object. Whether

these appear in the segmentation depends on the data and the wall settings.
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Lock and turn off the display of the blood

#+ Heart Segmentation - Volume Edit

File View Other Help

P o
pool object. In the Manual tab, select the B+ ® S

W[ original
Trace option. -1 e

B rors

B[] Left Coronary Artery
L] [Rightc

Create two new objects for the left e

Color |Blue @ Add Object
. . [] Display [ Locked @
and right coronary arteries. In the 3D

| Walls| Semi-Automatic| Manual

rendering, trace around each coronary E@ JE

Browse Trace

Trace el EZ:L"E Edge
artery with its respective object selected.

Draw on any of image to define a region. Draw on the
rendering to define a 3-D region along the viewing path. The
currently selected object defermines the newr region's
object

Auto Advance @ Off ©) Forward ©) Backward

Reset Seeds | | Reset Limits Redo Undo.

250
Point Picied = (222, 265, 321) Value=412 (Objec=Blood Poal)

20
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Turn the blood pool object back on
and unlock it, then lock and turn off the
other objects. Use Object Separator
to separate the left atrium from the left
ventricular blood pool. If the separation
is not correct, try clicking Undo and

selecting different seed points.

The separation can also be manually
adjusted. In order to perform manual
adjustments, click the Manual tab and
choose a manual tool such as Draw. Be
sure to lock the Original object when

making manual edits.

Tip: It is easiest to identify the boundary
between the left atrium and ventricle in the

transverse view. [t may help to toggle the

region display.

#+ Heart Segmentation - Volume Edit

File View Other Help

RO

S M8 original
(| 0l

=] o
12 B8] Left Coronary Artery
2 Sl Right Coronary Artery

W et atrium

Name Blood Pool

Color Red (=] ‘Add Object
4] Display [C] Locked

[

Edge Strength | Walls| Semi-Automatic| Manual

|-

Browse
Dra

rend
e

o Draw Nudge Spline
Edit  Edit

o define @
currently selected object defermines the new

object

ERI

Scale Deform
Edge Edge

region's

Undo

22

P13

Try defining the object on every 3, 5, or 7 slices, depending on the spacing of the slices in your data. Move through the slices by pressing

the + and - buttons on the keyboard. If using a spline, press the “a” key to apply the spline to that slice. Then, use Propagate Objects

under the Semi-Automatic tab.

Select the object to propagate, select Current Object, and select the orthogonal orientation in which the changes were made. Choose

smoothing if needed, then click Propagate. This will smoothly interpolate the modifications between slices.

Check the results in all orientations, and if necessary repeat the edits and propagation in another orientation.
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Rename the blood pool object to LV
Blood Pool, then lock and turn off that
object. The remaining displayed objects

are the left atrium and pulmonary veins.

Create four new objects for the pulmonary
veins: Left Superior Pulmonary Vein,
Left Inferior Pulmonary Vein, Right
Superior Pulmonary Vein, and Right
Inferior Pulmonary Vein.

Use the Trace tool under the Manual tab to
trace around each pulmonary vein on the

rendering with the correct object selected.

A+ Heart Segmentation - Volume Edit

File View Other Help

B

RO

S M8 original

Left Coronary Artery

S Sl Right Coronary Artery

Left Atrium
2 B[] Lett Inferior Puimonary Vein
(S B[] Lefe superior Pulmonary Vein

Name Right Inferior Pulmonary

Color #7d0d82 E‘

) g

[¥ Display ] Locked

Edge Strength | Walls| Semi-Automatic| Manual

Bl & o]k D1

Browse Trace Auts Draw Nudge Spline Scale Deform
Trace Edit Edit  Edge Edge

P
Psd
RE]
HE

Draw on any of image to define a region. Draw on the
rendering to define a 3-D region along the viewing path. The
cumrently selected object determines the new region's
object

Auto Advance ©) Off ® Forward () Backward

Reset Seeds | | Reset Limits Redo Undo

Point Piied = (282, 244, 211) Value=384 (Objeci=Left Atium)

2

P13
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In order to clean up the objects segmented so far R Objects - VolumeEdR S
and improve the rendering smoothness, we will —_
. . Control by Object @ Attribute Add
change some display settings. Object
Attributer  MNeighbors Used =
From the View menu, select Objects. In the Objects - Object Object Object gi;i_t;
window, select the Attribute radio button and Al w/Grad wo/Grad Smoothed s
. . Original @ 3
change the Attribute to Neighbors Used. e : Object(s)
LV Blood Pool | -] —
_ Remaowve
Change each object to Object Smoothed. This will Aorta @ Unused
smooth the 3D rendering. Left Coronary @ Load
Right Coronar @ Object(s)
Left Atrium e] Load
Bina
Left Inferior Pu @ Ay
. Save
Left Superior Fi @ Binary I
Right Superior : @ Trph
Right Inferior | @ Object
Filter
i Objects
| Done |
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Segmenting Regions
Outside the Blood Pool

Now we need to add the remaining
chambers of the heart to our
segmentation. The left ventricular
myocardium, and the right atrium and

ventricle are currently missing.

In this data set, those regions have a
lower intensity so were not included in the

initial region grow step.

Create a new object and lock all objects
but the new object and the Original
object. Under the Semi-Automatic tab,

select the Region Grow option.

A+ Heart Segmentation - Volume Edit

File View Other Help

| BT original
& @l Lv Biood Pool
S ons
(S B[] Left Coronary Artery
S Bl Right Coronary Artery
& W e atrium
2 B[] Lett Inferior Puimonary Vein
(S B[] Lefe superior Pulmonary Vein
S B[ Right Superior Pulmenary Vein
(& [l right Inferior Puimonary Vein

15 [object 11

Name Object 11

Color 2408080 :

Display [ Locked

L]

Opacity (0-100%)| 50

Browse © Threshold © Region Grow
) Connected Components () Object Extractor () Object Separator
©) Oblique Cutting ) Fill Holes ) Prapagate Objects
©) Reassign Object
Min Threshold Max
23 2
[7] Threshold Rendering
Bt Object
Reset Seeds | [Reset Limits Redo

e

a5

Point Piied = (215, 351, 232) Value=57 (Objec=Originsl)

Select a seed point and adjust the threshold range. For this step, a conservative threshold range is best to keep the region grow from

adding regions that are not part of the regions of interest.

After choosing a threshold range, click Extract Object. The remaining heart objects will be taken from this new object, then any extra noise

remaining will be deleted.
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In the new object, there will be several small holes. In order to clean up this object, we will apply a median filter.

Go to View > Obijects, then click the Filter Objects button on the bottom

filter, then click Filter.

The new object will be smoother and have most of the holes filled.

' = '
7. Fitt. ool e e S

Operation: Median -

X

5 5

B21®1®1
Fiter ©3 @3 © 3
Size @ 5@ 5 @5
EI®ETE®T
me9mem9

W

5

right. In the Filter Objects window, choose a 5 x 5 x 5 median

#'+ Heart Segmentation - Volume Edit

10
|@
I

File View Other Help

B

B[ Joriginal

&Sl Biood Pool

S B rcrs

SB[ Left Coronary Artery

S ERlRright Coronary Artery

S WLt atrium

S B[ Left Inferior Pulmonary Vein
B[] Left Superior Pulmenary Vein
2 BT Right superior Pulmonary Vein
2 EWRight Inferior Puimonary Vein

[ object 11

Name Object 11

Color [#408080 @

Display. [] Locked

L[]

Opacity (0-100%)| 50

Walls| Semi-Automatic |Manual

) Browse ©) Threshold ® Region Grow
) Connected Components () Object Extractor () Object Separator
ique Cutting © Fill Holes ) Propagate Objects
©) Reassign Object
Min Threshold Max
EE| #7

[¥] Threshold Rendering

Extract Object
Reset Seeds | [Reset Limits Redo

351

Point Picied = (215, 351, 262) Value=57 (Object=Driginal)
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Add a new object and call it LV et sgmension ol 6 (=T

File View Other Help

Myocardium. Lock the Original object. L RO

2 B[ original

& Bl LvBi00d Pocl

- . T e

With the LV myocardium selected, use a LT por

I | f h . d f_ h gggLﬂ[n‘;&‘::rPu\monaryVam

manual tool ot your choice to define the gg=;3j;g:::;‘:‘";gj;:;n
Right Inferior Pulmonary Vein

LV myocardium on every few slices, then

propagate the object as described before. Cor e[

Display 7] Locked
The spline tool works well for this. oty 0004 50

Edge Strength | Walls| Semi-Automatic

| manual

dge Spline e Deform
Edit  Edge Edge

The propagated region can be somewhat
. . . . Create a New Spline Region or Convert a current region info
jagged if not many slices were skipped s et e e e
control points. Use the left mouse button fo add new
control points. Use the Delete to delete control points.

between defining the object. Try defining e st e e i
. . . [ Smart Edge.
the object on every 5 or 7 slices (depending S

[] Lock Control Points

on the data). Applying an object filter can

Auto Advance @ Off © Forward () Backward

be used to smooth the boundary, but the

[Reset Seeds | [ResetLimits| [ Redo | [ Undo |

filter will be applied to all objects so it

may be best to wait until the end of the I T e e — =

Point Picied = (352, 274, 451) Value=50 (Objec=Object_11]

segmentation to apply an object filter.
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Next, we will define the right ventricle.
Create a new object and call it Right
Ventricle. Then follow a similar procedure

to that used to define the LV myocardium.

#+ Heart Segmentation - Volume Edit

File View Other Help

-8 5=

& M original
& @l Lv Biood Pool
S ons
(S B[] Left Coronary Artery
S Bl Right Coronary Artery
& W e atrium
2 B[] Lett Inferior Puimonary Vein
(S B[] Lefe superior Pulmonary Vein
S B[ Right Superior Pulmenary Vein
(& 0l right Inferior Puimonary Vein
[ object 11
S E]1v Myocardium
(W right Ventricle

Name Object 11

Coler 408080 @ Add Object
Display [ Locked

Opacity (0-100%)[ 50 [/

Semi-Automatic

i) Threshold *) Region Grow

) Object Extractor () Object Separator
©) Oblique Cutting © Fill Holes © Propagate Objects
©) Reassign Object

) Browse

©) Connected Comp

Specify Propagation Options, the press
Propagation Type: ©) Current Object ) All Objects
@ Transverse O Coronal

© Sagittal
Smoothing

Reset Seeds | [Reset Limits Redo

m

Display Mode = Traces
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The last remaining chamber of the heart

View Other Help

s 5

& M original -
h h h b & @l Lv Biood Pool

same way as the other chambers. ] T

(S B[] Left Coronary Artery

S Bl Right Coronary Artery

& W e atrium

2 B[] Lett Inferior Puimonary Vein

(S B[] Lefe superior Pulmonary Vein

S B[ Right Superior Pulmenary Vein

(& 0l right Inferior Puimonary Vein

& Wl object 11

S E]1v Myocardium

& B right ventricle

EL L Jright atrium

is the right atrium. We will segment it the

Name Right Atrium

Color [7a04000 [ Add Object
Display Locked

Opacity (0-100%)] 50

Edge Strength | Walls| Semi-Automatic

) Browse © Threshold ) Region Grow

|© Connected Components ©)
©) Oblique Cutting © Fill Holes @ Propagate Objects

bject Separator

© Reassign Object

Specify Propagation Options, the press
Propagation Type:
® Transverse

Smoothing

Rest Lt

Display Mode = Traces




WHOLE HEART SEGMENTATION USING ANALYZE

Now, all that is remaining in Object_11
is the pulmonary arteries and vena cava
along with some extra noise from the

initial region grow.

Create a new object and call it
Pulmonary Arteries. Lock all objects but
Object_11 and the pulmonary arteries.
Under the Semi-Automatic tab, select

the Region Grow option.

Select the pulmonary arteries object,
then define a seed point in the main

pulmonary artery. Choose an appropriate

threshold range, then click Extract Object.

#+ Heart Segmentation - Volume Edit

File View Other Help

Left Coronary Artery
Right Corenary Artery

Left Atrium

Left Inferior Pulmonary Vein
Left Superior Pulmonary Vein
Right Superior Pulmonary Vein
Right Inferior Pulmonary Vein
Object_11

B[] LV Myocardium

Name Pulmonary Arteries

2 @
Display [C Locked

Opacity (0-100%)] 50 |

Edge Strength| Walls| Semi-Automatic [Manual|

©) Browse ©) Threshald ~ ©) Region Grow
©) Connected Components () Object Extractor () Object Separator
) Oblique Cutting © Fill Holes ©) Propagate Objects

) Reassign Object

Min Threshold Max

| wdl [T 1 sha
|| ¥ Threshold Rendering

Extract Object
Reset Seeds | [ Reset Limits Redo

»
181

Display Mode = Tracss & Colored Regions,
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Delete Object_11. There are still some
parts of the pulmonary arteries object
that are not part of the pulmonary arteries

and need to be removed.

Use a manual method to reassign these
areas to a new object. Use the propagate
regions technique described earlier

by changing every few slices, then

propagating the new object.

#+ Heart Segmentation - Volume Edit .

Fle View Other Help

. 5o

=L Woriginal

& @l Lv Biood Pool

S ons

(S B[] Left Coronary Artery
S Bl Right Coronary Artery
& W e atrium

2 B[] Lett Inferior Puimonary Vein
(S B[] Lefe superior Pulmonary Vein
S B[ Right Superior Pulmenary Vein
(& Wl right Inferior Puimonary Vein
& @] Ly myocardium

S W right Ventricle

& E Wl right Atrium

2 S puimonary Arteries

Name|Original

Color White @ 5
] Display Locked

Opacity (0-100%)] 50 |

Edge Strength | Walls | Semi-Automatic| Manual

B gl B O

Browse Trace Auto Draw Mudge Spline Scale Deform

Trace Edit  Edit  Edge Edge

Draw on any of image to define a region. Draw on the
rendering to define a 3-D region along the viewing path. The
currently selected object determines the new region’s
object.

Pen Shape: |i !j ﬂ

Pen Size: |

Current Pen:

Auto Advance © Off () Forward ©) Backward

Rescsecs ] [Rest i

Point Picied = (103, 235, 441) Value=164 (Object=Pulmonsry Arteries)

»
103
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Now we will separate the vena cava from

the pulmonary arteries.

Drawing a spline around the vena cava
and setting Auto Advance to Forward
(or Backward if starting at the high end)

works well for this.

#+ Heart Segmentation - Volume Edit N

File View Other Help

85

& M original

& @l Lv Biood Pool

S ons

(S B[] Left Coronary Artery

S Bl Right Coronary Artery

& W e atrium

2 B[] Lett Inferior Puimonary Vein
(S B[] Lefe superior Pulmonary Vein
S B[ Right Superior Pulmenary Vein
(& Wl right Inferior Puimonary Vein
& @] Ly myocardium

S W right Ventricle

& E Wl right Atrium

2 S puimonary Arteries
EL [T vena Cava

na Cal

Name Vena Cava

Color [#408080 [ 2] Add Object
Display Locked

Opacity (0-100%)] 50 [m]

Edge Strength | Walls| Semi-Automatic| Manual

B & &) e| BT

Browse Trace Autc Draw Nudge Spline Scale Deform ||f

Edit  Edit  Edge Edge

Create a New Spline Region or Convert a current region info
& Spline. When creating a new spline region, double click
when finished. Use the middlle mouse button to adjust
conirol points. Use the left mouse button o add new
control points. Use the Delete to delete control points.
When complete, click Apply to convert the spline back fo
an object region.

© New Spline ©) Convert to Spline
[ Smart Edge
Sensitiity ]

Lock Control Points
Auto Advance ©) Off ® Forward (©) Backward

Reset Seeds | | Reset Limits Redo Undo

| Copyrignt 1985:2014, BIR. Mayo Clinic
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Lastly, there are a few holes in the
pulmonary arteries and vena cava. Go

to View > Objects and click the Morph
Object button in the bottom right of the

Objects window.

Change Object to Vena Cava, Operation
to Fill Holes, and Defined Object to Vena
Cava. The default setting should work
fine. Click Morph to perform the Fill Holes
operation. Repeat this process with the

Pulmonary Arteries object.

Save the object map by going to File >
Save Object Map and choosing a directory.

#+ Heart Segmentation - Volume Edit .

Fle View Other Help

.5 om

& M original

& @l Lv Biood Pool

S ons

(S B[] Left Coronary Artery
S Bl Right Coronary Artery
& W e atrium

2|0

(S B[] Left superior Pulmonary Vein
S B[ Right Superior Pulmenary Vein
(& Wl right Inferior Puimonary Vein
& @] Ly myocardium

S W right Ventricle

& E Wl right Atrium

2 S puimonary Arteries

S EEvens cova

Name Left Inferior Pulmonary

Coor [en [

Add Object
Display Locked

Opacity (0-100%)] 50 | m{m|

Edge Strength | Walls| Semi-Automatic| Manual

B[ <] o] B9 O

Browse Trace Autc Draw Nudge Spline Scale Deform |f
Trace dit Edit  Edge Edge

Draw on any of image to define a region. Draw on the
rendering to define a 3-D region along the viewing path. The
currently selected object determines the new region's
object.

Auto Advance ©) Off ® Forward ©) Backward

Reset Seeds | | Reset Limits Redo Undo.

L 29 R

Point Picied = (223, 218, 623) Value=256 (Object=Aoria)
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